
 
 



POWERDESIGN VERSION 1.41 
 
 

 
     www.itec-audio.com POWERDESIGN VERSION 1.41    
 
2 

Content    
 
POWERDESIGN 
 
 

1. POWERDESIGN .............................................................................................................5 
1.1 Hints for a Quick Start ...........................................................................................5 

1.2 Software Components ...........................................................................................6 
1.2.1 Project .............................................................................................................................. 7 

2. File ..................................................................................................................................8 
2.1 Open project ...........................................................................................................8 

2.2 Save project ............................................................................................................8 

2.3 Save project as... ....................................................................................................9 

2.4 Print project ............................................................................................................9 

2.5 Printer setup ...........................................................................................................9 

3. Edit ............................................................................................................................... 10 
3.1 New project ........................................................................................................... 10 

3.2 Project preferences .............................................................................................. 10 

3.3 Copy Configuration .............................................................................................. 10 

3.4 Paste Configuration ............................................................................................. 10 

3.5 Paste predefined configuration ........................................................................... 10 

4. View .............................................................................................................................. 11 
4.1 Basic configuration .............................................................................................. 11 

4.1.1 Configuration of Input Streams: ..................................................................................... 12 
4.1.2 Configuration of the Automatic Mixer: ........................................................................... 13 
4.1.3 Equalizer Display and Routing ...................................................................................... 14 

4.2 DSP Settings......................................................................................................... 15 
4.2.1 Equalizer ........................................................................................................................ 16 
4.2.2 Output Volume ............................................................................................................... 17 
4.2.3 Features to Make Handling Filters Easier ..................................................................... 17 

4.3 Measurement ........................................................................................................ 17 
4.3.1 Input Measurement ........................................................................................................ 18 
4.3.2 Output Spectral Analyzer/VU Meter .............................................................................. 18 
4.3.3 Battery State: ................................................................................................................. 18 
4.3.4 Set and Enable the Visible Sliders for the Actual Config .............................................. 19 

 

 



POWERDESIGN VERSION 1.41 
 
 

 
     www.itec-audio.com POWERDESIGN VERSION 1.41    
 
3 

4.4 System Configuration .......................................................................................... 20 
4.4.1 Bootup Settings ............................................................................................................. 21 
4.4.2 Startup Menu Settings ................................................................................................... 21 
4.4.3 Remote Control Type .................................................................................................... 21 
4.4.4 AGM Settings ................................................................................................................. 21 
4.4.5 Assembly variant ........................................................................................................... 22 

5. Tools ............................................................................................................................ 23 
5.1 Verify connection & device (Go online) .............................................................. 23 

5.2 Read all configurations from device ................................................................... 23 

5.3 Reload current configuration from Flash ........................................................... 23 

5.4 Verify current configuration ................................................................................ 23 

5.5 Verify project ........................................................................................................ 23 

5.6 Switch to other device ......................................................................................... 23 

6. Update .......................................................................................................................... 24 
6.1 Store current configuration (into Flash) ............................................................. 24 

6.2 Send project to device and store (into Flash) .................................................... 24 

6.3 Send current configuration from PC to device (RAM only) ............................... 24 

7. EXTRAS ....................................................................................................................... 25 
7.1 DSP Specials ........................................................................................................ 25 

7.2 Gong Editor .......................................................................................................... 25 

7.3 User tone control ................................................................................................. 26 

7.4 Preferences .......................................................................................................... 26 
7.4.1 Serial port configuration ................................................................................................. 26 
7.4.2 Scale main window ........................................................................................................ 27 

7.5 Search for new software online... ........................................................................ 27 

7.6 Search for New Software Locally ........................................................................ 28 

8. Media Remote Control ................................................................................................ 29 
8.1 RS-232 Settings .................................................................................................... 29 

8.2 Interface Definition ............................................................................................... 29 

 

 

 

 

 



POWERDESIGN VERSION 1.41 
 
 

 
     www.itec-audio.com POWERDESIGN VERSION 1.41    
 
4 

8.3 Commands ........................................................................................................... 30 
8.3.1 Set value (Command 0x80) ........................................................................................... 31 
8.3.2 Increase value (Command 0x81) .................................................................................. 31 
8.3.3 Decrease value (Command 0x82) ................................................................................. 32 
8.3.4 Switch to Configuration (Command 0x83) ..................................................................... 32 
8.3.5 Toggle Mute (Command 0x89) Firmware 1.22 .............................................................. 32 
8.3.6 Set Slider Control (Kommando 0x94) Firmware 1.22 .................................................... 33 
8.3.7 Get Data (Command 0xA0) ........................................................................................... 33 
8.3.8 Get Ram Range (Command 0xB0) ............................................................................... 33 

8.4 Response Packet ................................................................................................. 34 
8.4.1 Response-Packet (Commands 0x80-0x9F) .................................................................. 34 
8.4.2 Response-Packet (Commands from 0xA0) ................................................................... 34 

8.5 Communication Examples POWERMIX/RPSUCCESS – Remote Control ......... 35 

9. Appendix ...................................................................................................................... 36 
9.1 Document Versioning .......................................................................................... 36 

9.2 Contact Information ............................................................................................. 36 
 
 
 
 
Tables 
 
Table 8-1 Addressing Modes ................................................................................................30 
Table 8-2 Media Control Commands ....................................................................................31 
Table 8-3 Get Ram Range Command ..................................................................................33 
 
Figures 
 
Figure 2-1 Open project ......................................................................................................... 8 
Figure 4-1 Automixer ............................................................................................................13 
Figure 4-2 DSP Settings .......................................................................................................15 
Figure 4-3 Measurement view ..............................................................................................18 
Figure 4-4 Control the visible sliders .....................................................................................19 
Figure 4-5 System Configuration ..........................................................................................20 
Figure 7-1 Serial port configuration.......................................................................................26 
Figure 7-2 Software update: no updates available ................................................................27 
Figure 7-3 Firmware update notification ...............................................................................28 



Chapter 1: POWERDESIGN 
 

 
     www.itec-audio.com POWERDESIGN VERSION 1.41   
 
5 

1. POWERDESIGN 
POWERDESIGN is the PC software for the mixer system ITEC POWERMIX 6/3 digital and 
ITEC Lectern Success. 
 
POWERDESIGN can be used to configure and test these sound systems. The configuration 
created with POWERDESIGN are saved to a flash memory chip inside the system. It will not 
be lost during a power outage.  
 
A configuration comprises all settings required for stand-alone operation as well as custom 
settings. 
 
The flash memory of your device stores up to 5 different configurations. You can set the 
default configuration using POWERDESIGN (see Startup Menu Settings) You can switch 
between configurations using the touch screen display or the remote control of your device.  
 
The latest version of POWERDESIGN is available free of charge. You can download it here: 
http://itec-audio.com/download/powerdesign/powerdesignsetup.exe 
 
 
 
 
 
1.1 Hints for a Quick Start 
If there is no device connected, you can choose to… 

• Create a new project Edit > New Project 
• Open an existing project File > Open Project 

 
POWERDESIGN will ask you to specify the name of the project and the device to be 
configured (Lectern Success or POWERMIX digital). You can then prepare a configuration 
for your device. You can save this configuration:  File > Save Project 
You can transfer the configuration to your device:  Update > Send project to device and 
store 
 
Please see chapters 2 File, 3 Edit and 6 Update for details. 
 
If POWERDESIGN detects a device connected using the RS-232 serial interface, it will 
automatically transfer the device settings to the PC on start up. You’re all set. 
 
 
 

http://itec-audio.com/download/powerdesign/powerdesignsetup.exe
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1.2 Software Components 
 
When you install POWERDESIGN on your PC, the installation routine will create a folder 
powerdesign and a subfolder data. The powerdesign folder contains the main program file 
powerdesign.exe and the firmware file powerdesignfirmware_x.bin. The data folder contains 
a collection of predefined projects. 
 
POWERDESIGN.exe 
The main program file. 
 
POWERDESIGNfirmware_x.bin 
The firmware file. It needs to be transferred to your device. This file is language specific. 
Depending on your language, the file is named differently.  
 

• powerdesignfirmware_e.bin (for English) 
• powerdesignfirmware_g.bin (for German) 
• powerdesignfirmware_f.bin (for French) 
• powerdesignfirmware_d.bin (for Dutch) 

 
data/Seminarraum.pdp  
This file contains a sample project. You can have a look at it to get used to the software. 
 

        FIRMWARE: e.g. powerdesign_e.bin 
        PROJEKT:  e.g. Seminarraum.pdp 

 
 
 
 
 
 
 
 
 
 
C:\programs\powerdesign 
  POWERDESIGN.exe   
  POWERDESIGNfirmware_e.bin 
  POWERDESIGNfirmware_f.bin 
  POWERDESIGNfirmware_g.bin 
  POWERDESIGNfirmware_d.bin 
 
C:\programs\powerdesign\data (projects) 
  Seminarraum.pdp  
  Stadttheater.pdp 
  Turnhalle.pdp 
 

 

Serial Connection 
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1.2.1 Project 
 
A project is a container for up to four configuration sets that in turn store all settings that you 
can configure for a sound system. The extension of the project file is pdp (for Power Design 
Project) 
 
A configuration can be transferred to the flash memory of a sound system and can also be 
archived on a PC. You can create configuration sets to fit different operating environments 
like outdoor or indoor venues. You can easily switch between configurations sets on the 
sound system by using the touch screen.  
 
The configuration named “last configuration” has a special status. This configuration is 
created automatically once a minute (except battery powered devices: they create the 
configuration at power down only). It allows you to seamlessly continue operation with the 
settings you used previously although the device was powered down. 
 
You can also set properties for a project. You can use these properties to define the kind of 
sound system you want to program. Examples for project properties include display contrast, 
serial number, slider labels and start-up behavior.  
 

 
Projekt  SEMINARRAUM 
 
 
 
Konfiguration 
Für verschiedene Anwendungen können sogenannte Konfigurationen erstellt werden. Sie 
enthalten im wesentlichen die Lautstärke- und Klangeinstellungen. Das Umschalten 
zwischen den Konfigurationen ist sehr einfach durch einen „Tastendruck“ am Touch-Screen 
möglich. 
Eine Besonderheit stellt die Konfiguration „Letzte Einstellung“ dar. Sie wird automatisch 
erstellt (bei Geräten mit Akku beim Ausschalten bzw. im Minutenzyklus bei Geräten mit 
ausschließlich Netzversorgung) und dient dazu, nach einer Pause bzw. Unterbrechung 
wieder mit den zuletzt verwendeten Einstellungen weiterzuarbeiten. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Project Preferences 
       Project Name(z.B. SEMINARRAUM)  
       Description 
 
System Settings 
   Serial number 
   Contrast, illumination 
   Automatic Gain adjustment settings  
   Control labelling 
   Master control assignment 

Configuration 4 
z.B. KONFERENZ 

 
 

Project: SEMINARRAUM 

Configuration 3 
 z.B. NUR AUFNAHME 

 
 

Configuration 2 
 z.B. SAAL GETEILT 

 
 

                      Configuration 1 
                             z.B.STANDARD 
 
INPUT GAINS (Kanal 1-6) 
MICRO / LINE ( Kanal 3-5) 
PHANTOMPOWER. (Kanal 3-5) 
SIGNAL-ROUTING 
EQUALIZER SETTINGS 
  (5 Input-, 3 Output-EQs) 
OUTPUT VOLUME 
START VOLUME for 6 controls 
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2. File 
 
This menu allows you to open, save and print project data. Projects that have been recently 
worked on can be opened directly from the menu. 
 
2.1 Open project 
If you select “Open Project“, a dialog providing an overview of all previously saved projects 
will appear. Project files are listed in the following order. 
 

 Search1: all projects found in folders that are configured as search paths 
 

     Recent projects 
 
  More projects...: This option opens a standard file open dialog 

 
You can add as many project directories to the search paths as you like. You can do this by 
accessing the context menu (right mouse button) of the project list and selecting “Add search 
path...”.  
 
 

 
Figure 2-1 Open project 

 

 
 
 
 
2.2 Save project 
This option saves the current project to disk. The file will be named after the project name of 
the current project. 
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2.3 Save project as... 
 
If you want to save your project with another filename, select this option. Please note that the 
actual project name will not be changed. If you want to change the project name, select Edit 
> Project Preferences. (see Chapter 3.2) 
 
2.4 Print project 
This option prints all project settings. 
 
2.5 Printer setup 
This option allows you to configure the printer used to print your project via the standard print 
dialog provided by MS Windows. 
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3. Edit 
 
The Edit menu allows you to create and work on projects. You can also copy and paste 
configurations.  
 
3.1 New project  
This option creates a new project. The first step in creating a project is to specify the project 
preferences. These include the following. 
 
a) Project name 
 Will be the filename of the saved project file by default. You can change this filename by 

selecting File > Save project as… 
 Is displayed on the sound system when selecting “Info” from the sound systems menu.  
b) Description  
 You can enter an explaining text, which will be displayed on the sound system on the info 

page. Maximal length is 46 characters. 
c) Select device 
 If a sound system is connected, its type will be detected automatically. If not, you have to 

specify what sound system you want to create configuration sets for using this setting 
(Lectern Success or POWERMIX) 

 
 
3.2 Project preferences  
You can change the project preferences specified at project creation using this option. 
 
3.3 Copy Configuration  
 
Copy Configuration will save the settings of the current configuration to the clipboard. You 
can then paste the configuration settings to another configuration using the option Paste 
Configuration. 
 
3.4 Paste Configuration 
 
The settings of a configuration that was previously copied to the clipboard can be inserted to 
the current configuration using this option. Caution: the settings of the current configuration 
will be overwritten. 
You can also paste configurations to other projects. 
 
3.5 Paste predefined configuration  
You can reset your current configuration to the factory settings using this option. This 
overwrites the current configuration settings. 
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4. View  
 
 
4.1 Basic configuration 

 
The view „basic configuration“ is the first screen you will see after starting up the program.  
 

The menu option View > Basic Configuration or the  button will take you back to this 
screen at any time. 
  
Tool bar                 Switching between configurations sets,                                    
                                          Change name of configuration    Save current configuration 
 

 
 
 
Bar for notifications and status messages 
 
Number of current configuration and last modified date and time 
A click into this field allows you to change the current configuration 
 
Display to show if data has been written to the flash 
memory of a connected sound system 
 
Status display:  Green: Connected to a sound system 

Red: Error during data transfer 
   Dark: No connection 
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4.1.1 Configuration of Input Streams: 
 
 

   
 
 
You can specify the custom names in the view „System Configuration“. These will be 
displayed as the labels of the corresponding slider  on the sound system. 
 
You can set the input amplification in dB with a 0.5 dB stepping. 
 
Note:  
Not all input streams offer all of the settings described above. This is due to the architecture 
of the DSP. 

• Inputs 1 & 2 are phantom powered microphone amplifiers 
• Inputs 3, 4 & 5 can be used as microphone or Line-In sockets. Phantom power 

(12V+) can be toggled on/off 
• Input 6 is always a Line-In socket 
• Input equalizers 1-3 can by configured for any of the inputs 1-4. 
• Inputs 5 & 6 are hard linked to equalizers EQ4 and EQ5 

Custom name (5 chars) 
 
Set the maximal amplification of the input [dB] 
 
Switch the input amplifier between Mic / Line  
 
 
Phantom power on/off 
 
 
Toggle input equalizers 
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4.1.2 Configuration of the Automatic Mixer: 
 
Every ITEC POWERMIX 6/3 is equipped with an automatic microphone mixer. A 
sophisticated algorithm ensures determination of the microphones that are used even at high 
ambient noise levels.  
 
In switching mode, only one microphone is active at the same time. In mixing mode, multiple 
microphones can be active. The overall volume will be reduced to avoid acoustic feedback 
and reverberation. This is done by a NOMA circuit. NOMA is an acronym for Number of 
Open Microphones Attenuator.  
 

 
Figure 4-1 Automixer 

  
 
The value you enter in the field labelled „Attenuation” determines how much the amplitude of 
non-active microphones will be lowered, expressed in dB. Higher attenuation values increate 
the effect of the auto mixing. However, this may result in a change of sound ambience when 
switching between microphones. Good settings range from 12 to 18 dB. Higher settings can 
make sense under very bad acoustic conditions.  
 
Hysteresis determines the difference in dB that a microphone has to be louder than the 
currently leading microphone in order to become the new lead. Low settings lead to frequent 

Auto mixer On/Off 
 
Attenuation of non-active microphones 
 
Hysteresis  
 
 
Soft NOMA 
Toggle mixing mode     
 
Bandbreite innerhalb welcher zusätzliche Mikrofone 
aktiv werden können 
 

Maximum number of concurrently active microphones 
 
 
 
 
 
 
Selection of input channels 
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switching between microphones. High settings make the system switch rather inertial. Good 
settings range from 2 to 3 dB.  
 
Mixing mode allows multiple microphones to be active, but only if the amplitude of their signal 
is within a defined bandwidth (a so-called gate) around the leading microphone. You can set 
the size of this gate. Good settings range from 3 to 6 dB. 
 
You can define the maximum number of concurrently active microphones with the setting 
“Max Channels”.  
 
Soft NOMA enables a smooth reduction of the overall volume when additional microphones 
are activated in mixing mode when selected. 
 
 
4.1.3 Equalizer Display and Routing 
 
 
 

Name tag (max. 8 Characters) fort he 
equalizer (will not be displayed on the sound 
system) 
 
 
 
 
Routing to output channel 2 

Routing to output channel 1 
 
You can get a quick overview of the equalizer settings by looking at the frequency spectrum of the channels. 
A double click on one of the EQs will take you to the DSP settings for that channel. The 
context menu (right mouse button) of an EQ allows you to copy and paste equalizer settings. 
 
Switches 1 and 2 determine the routing of the signal from the input EQs to the output EQs. 
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4.2 DSP Settings 
You can access this view with the menu option View > DSP Settings or by pressing this 

button:   
 
You can configure all settings that change the sound of the individual channels from within 
this view. The result of the current settings is displayed graphically on a frequency band 
ranging from 10 Hz to 20 kHz. 
 

 
Figure 4-2 DSP Settings 

 
  You can select the channel you want to work on using this selection bar. 
 
Input channels (EQ1 to EQ5):  

The input channels can be configured with up to 4 filters except channels, 
which are activated by the user tone control (see 7.3) This channels can be 
configured with 2 filters only, and they can be adjusted with an additional 
treble and bass control directly on the sound system. 
Filter types include peakfilter, treble- and bass shelving.  
(see also filter types, chapter 4.2.1) 

 
Output channels: 

Output channels can be configured with up to 12 filters. Filter types include 
peakfilter, high pass and low pass.  
(see also filter types, chapter 4.2.1) 

 

1 

1 
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4.2.1 Equalizer 
 
The sound processing unit (DSP) is equipped with 12 filters on every output and 4 filters on 
every input channel. 
 
Filter Types:  
 

 Peakfilter: Attenuates or amplifies a certain frequency band 
                              You can configure the following parameters: 
 

- Amplification/Reduction in ½ dB steps within a range from -15 to +15 dB. 
- Frequency f: Configurable in 1/8 octave steps within a frequency band from 20 Hz to 20 kHz. 
- Quality Q:     setting range from 0,1 to 100.  

                                  
Quality

Frequency
defines the bandwidth of the filter. A quality setting of 10 

produces a bandwidth of 160Hz at a frequency of 1600Hz. 
 
Filter types that can be used alternatively at the inputs: 
 

  Lowshelving: To amplify or attenuate frequencies below the preset marginal frequency f 
for a maximum of ± 15dB. 
 

  Highshelving: To amplify or attenuate frequencies above the preset marginal frequency f 
for a maximum of ± 15dB. 
 
Filter types that can be used alternatively at the outputs: 
 

 Lowpass: Frequencies below the cut-off frequency are passed through the filter  
 without modification. Frequencies above are attenuated by 12dB / octave  
 (2nd order filter).  
 . 

 Highpass: Frequencies above the cut-off frequency are passed through the filter  
 without modification. Frequencies below are attenuated by 12dB / octave.  
 
You can find the following switches below the equalizer. 
 
Flatten:  All sliders are reset to 0 dB. 
Default values:  Default settings are restored (peakfilter, quality of 1, amplification of 
0dB). 
Sort by frequency:  The filters are sorted by frequency from left to right.  
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4.2.2 Output Volume 
 
 
 
 

  The 3 output equalizers are equipped with a slider 
to  
  set the output volume. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4.2.3 Features to Make Handling Filters Easier 
 
Copy and paste of equalizer settings 

1. Move the cursor to somewhere within the equalizer graph and press the right mouse 
button.  
Copy the equalizer settings to the clipboard by selecting “Copy EQ“  

2. Switch to the equalizer you want to paste the settings to. 
3. Place the cursor in the equalizer graph and press the right mouse button again. 

"Paste EQ" will paste the previously saved settings.  
 
Save and load equalizer settings 

1. Move the cursor to somewhere within the equalizer graph and press the right mouse 
button. 

2. You can save the settings of the current equalizer by selecting "Save EQ to file..." 
3. You can load equalizer settings from disk by selecting "Load EQ from file" 

 
 
 
 
4.3 Measurement 
You can access this view with the button:  or by selecting the menu option View > 
Measurement 
 
The screen shows the input and output levels and the battery levels if operating on 
rechargeable battery. 
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You can also configure the start-up volume of the sliders on this screen. 
 
 

 
Figure 4-3 Measurement view 

 
4.3.1 Input Measurement  

This part of the screen shows the input levels after processing of the slider settings 
(postfade mode). 

 You can also measure the levels directly at the inputs by switching to prefade mode. 
        

4.3.2 Output Spectral Analyzer/VU Meter 
This top right section shows the output level and the frequency spectra of the 3 
outputs. 
 

4.3.3 Battery State: 
(Only for devices with integrated rechargeable battery) 
Displays voltage and current information, and the remaining battery level. 
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4.3.4 Set and Enable the Visible Sliders for the Actual Config 
You can remote control the up to 6 sliders on the device from this part of the screen. 
 
You can check the current slider positions on a connected device by pressing “Read 
Values from Device”.  
 
The slider positions that are initially displayed are read from the flash memory of the 
connected device. 
 

 
Figure 4-4 Control the visible sliders 

 
You can set all sliders to 0 dB by pressing the button “Mute all Sliders”.  
 
You can save the slider positions as “Start-Up Volumes“ to the active device 
configuration by pressing the button “Save as Start Volumes” after you have set the 
sliders as desired. 
 
Please note that the settings are not saved to the flash memory of the device until 

you press this button on the tool bar: .  
 
The switch “Active“ right above each slider mutes the corresponding channel. Sliders 
that are muted will not be visible on the display of the sound system.  
 
You can copy the switch status (“active” or “muted”) for a channel into all 
configuration sets using the context menu of the “Active” switch.  
 

 
 
Access the context menu by moving the cursor over the switch and pressing the right 
mouse button. If you select “Copy this setting (all bits) into all FLASH configurations”, 
the switch status is copied to all configuration sets and saved to the flash memory of 
the device. 
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4.4 System Configuration 
 

You can access this view by pressing this button:  or by navigating to the menu option 
View > System Configuration 
 
You can set the fundamental device settings using this screen. Examples would be display 
parameters and slider labels.  
 
The settings you configure on this screen are stored independently from the device 
configuration sets. You have to save the settings explicitly by pressing “Save System 
Settings”.  
 
Some settings take effect immediately (like contrast), some require the device to be turned 
off and on again. 
 

 
Figure 4-5 System Configuration 

 
• Device Information: 

This section shows fundamental device specific information. 
 
• Display Settings: 
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You can set the contrast and backlight time of the device display. The display 
illumination is activated whenever the master volume control or the touch screen are 
operated. It will remain lit for the time period you configure here. 
 

• Set Names and Features for the Visible Sliders: 
You can enter the labels of the sliders in this section. You can use a maximum of 5 
characters per slider. The buttons labelled  link the corresponding slider to 
the master volume control. The volume of a channel that has this button deactivated 
will not be affected by master volume control operation.  
 

4.4.1 Bootup Settings 
 
This view allows you to specify settings that determine the start-up behaviour of the sound 
system.  
 
Enable Gong Button 
Toggles the gong functionality.  
If the gong button is deactivated, it will not be displayed on the screen of the device. 
 
Enable Media Control Menu 
In Preparation 
 
Display Locked on Start-Up 
You can lock the touch screen of the device after a configuration has been selected by 
activating this setting. It can be unlocked by pressing the unlock button on the display. 
 
4.4.2 Startup Menu Settings 
 
The sound system will display the start menu after start-up. You can then select a 
configuration.  
 
If you activate the switch “Enable Menu Timer”, the default configuration is loaded 
automatically after the timer period has expired. You can set the default start configuration 
with “Start with”.  
 
4.4.3 Remote Control Type 
You can set the type of the remote control here. 
Currently only the Serial interface/RF-UART is valid and working. 
 
4.4.4 AGM Settings 
This view is only available for the lectern Success. 
AGM is short for Automatic Gain Mode. You can configure the AGM using this screen. 
 
The following values are used to determine the level of the lectern’s microphones. 
 
Threshold[dB]:  Threshold at which acoustic feedback is detected in AGM.  
   default setting: -10dB 
Attenuation[dB]: dB value that determines how much the signal is attenuated after 

acoustic feedback has been detected. 
Timing[ms]:  Determines the stepping how fast AGM adjusts the volume. Setting is  

in milliseconds. 
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The optimal level for the lectern microphones is determined automatically during AGM 
operation. The level of the other channels is adjusted accordingly. This calculation can be 
corrected by entering offset values if necessary. 
 
4.4.5 Assembly variant  
This view is only available for the sound system POWERMIX 
Integrated Battery Pack  
You have to activate this switch if you want to use a rechargeable battery with your device. 
 
Integrated Second Amplifier 
You have to activate this switch if a second amplifier is built in.  
 
These settings are configured by the factory. A modification by the user is necessary only if 
the sound system is upgraded or refitted.  
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5. Tools 
 
5.1 Verify connection & device (Go online) 
 
Checks the connection to the device. If the connection was interrupted, it will be re-
established. 
 
5.2 Read all configurations from device 
 
This will read all configuration sets from the connected device into POWERDESIGN. 
 
5.3 Reload current configuration from Flash 
 
Loads the configuration set that is currently being modified in POWERDESIGN from the flash 
memory of the device. The settings in POWERDESIGN will be overwritten. This may be 
useful if you want to step back to a previous configuration stage. 
 
5.4 Verify current configuration 
  
Checks for incompatible or implausible settings in the current configuration like line-level 
inputs with activated phantom power. Incompatibilities are listed and categorized into 
information, warning and error. 
 
5.5 Verify project 
Performs the integrity check as in 5.4 for all configuration sets within the project. 
 
5.6 Switch to other device 
 
Opens dialog for a quick switch between devices. This will search all serial PC interfaces for 
connected devices. 
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6. Update 
 
 
6.1 Store current configuration (into Flash) 
 
Selecting this option will store the current configuration in the flash memory of the connected 
device. 
 

You can alternatively press the  button on the tool bar. 
 
6.2 Send project to device and store (into Flash)  
 
Stores all configuration sets of the project in the flash memory of the connected device. 
 
6.3 Send current configuration from PC to device (RAM only) 
 
The current configuration will be stored in the RAM memory of the connected device. The 
RAM will be cleared every time the device is switched off. If you want to store the 
configuration permanently, you have to select “Store current configuration into flash”. 
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7. EXTRAS 
 
7.1 DSP Specials 
 
A digital delay could assigned to one of the 3 output channels. 
Maximum delay time is restricted to 42.5ms 
 

 
 
Dithering is not editable as default. 
This function is used to minimize digital noise and it’s optimal configurated. 
 
7.2 Gong Editor 
 
This option allows the modification of the gong signal stored in the device. 
The user can select one of the 5 predefined sounds, or define a new one (up to 10 tones) by 
using this dialog window.  
The “Save” button could be used to store the selected gong signal into the flash memory of 
the device. 
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7.3 User tone control 
 

 
The tone control on the device, could be configured since 
firmware version 1.27 
Until now this function only affects the line input channel of the 
device. This dialog could be used to select the requested 
channel(s), which affected by user control on the device. 
 
If no channel is selected, line input tone control is used for 
default 
 
 
The “Save” button could be used to store the setting into the 
flash memory of the device. 
 

 
7.4 Preferences 
 
7.4.1 Serial port configuration 
 
Selecting this option will open a dialog that allows you to configure the serial interface. The 
default setting is “Automatic”, which will search all serial ports for connected devices.  
You can change this setting to “Manual” and set the serial port yourself if desired.  
 
 

 
Figure 7-1 Serial port configuration 

 
If you activate the checkbox „Choose device to connect to if more devices were found in 
Auto mode“, you will be prompted to choose the device you want to configure if more than 
one device was found during the port scan. 
 
„Use long timeout“ can solve driver problems with USB-to-Serial converters.  
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The button „Advanced“ will bring up a dialog that displays all available ports of the PC. You 
can deactivate ports in case of connectivity problems by toggling the  symbol in the 
corresponding line.  
 
7.4.2 Scale main window 
 
Since version V1.30, PowerDesign is able to scale the main window. 
This feature allows the adjustment to a given screen resolution 
 
7.5 Search for new software online... 
 
If you are connected to the internet, POWERDESIGN can download the latest updates for 
the program and device firmware directly from the ITEC website and update them by  
 

1) Download the software 
2) Update the device firmware 
3) Update Windows software 

 
 
Download the software 
The downloaded files are stored in the POWERDESIGN folder. 
 
If there are no updates available you will be notified as shown in Figure 7-2 
 

 
Figure 7-2 Software update: no updates available 

 
Update device firmware:   
 
After some initial checks you will be prompted to choose the language of the firmware.  
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The next dialog prompts you to confirm the firmware update.  
 
 

 
 
If the latest version of the firmware is installed already, there will be no update. 
 
If the firmware of the device has a later version than the version with which you chose to 
update the device firmware, you will be notified as shown in Figure 7-3 
 
 

 
Figure 7-3 Firmware update notification 

After the firmware update, the device firmware will reboot.  
 
A lectern Success that is connected to a wall socket will shut down. You have to switch it 
back on again. 
A POWERMIX or a lectern Success in battery mode will show the menu for choosing a 
configuration. 
 
Update Windows Software: 
If a new version has been detected and downloaded, you can execute the setup program. If 
an instance of POWERDESIGN is running at that time, it will be shut down. 
 
 

7.6 Search for New Software Locally 
 
You can also search the POWERDESIGN folder on your PC and all attached media for new 
versions of POWERDESIGN and device firmware using this option. 
 
The files that POWERDESIGN will search for are “powerdesignfirmware_x.bin” and 
“POWERDESIGNSetup.exe”.  
The “x” in the filename stands for the language of the firmware.  
Examples: 
powerdesignfirmware_g.bin : G for German 
powerdesignfirmware_e.bin : E for English 
 
The installation will proceed as described in chapter 7.5 Search for new software online... 
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8. Media Remote Control 
 
The following chapters describe commands and details of the media remote control. These 
are available with device firmware versions starting from 1.20. 
 
8.1 RS-232 Settings 
 
Baud rate: 19200  
Data bits:  8 
Parity:  none 
Stop bits: 1 
 
 
8.2 Interface Definition 
 
The communication between sound systems like POWERMIX and RPSUCCES and external 
media remote controls follows a certain schema. 
 
- Command of the external device (5 Bytes) 
- Response of the device(5 Bytes) 
 
The external device has to wait for the response of the local device to know if the command 
has been processed correctly on the local device. Any other commands will be ignored by 
the device until the response is received.    
 
 
Typical response times range from 15 to 20 Milliseconds, command 0x83 may take longer.  
 
 
Packet of the Command: 
 
 

Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 
DeviceID Command ValueID Value <CR> 

 
DeviceID: The first 6 bits of the byte represent the device ID. The last 2 bits specify the  

addressing mode (see Table 8-1). 
 
Valid range for the device ID:  
1..63  (default = 1) 

   
Addressing modes specify the device that can execute a command and the device that 
sends a response. There can be three different addressing modes.  
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DeviceID  Addressing Mode Description 
00xxxxxx Standard The device with the corresponding ID 

executes a command and sends the 
response. 

01xxxxxx NoAnswer The device with the corresponding ID 
executes a command but will not send a 
response. 

11xxxxxx Broadcast All connected devices execute the command, 
no device sends an answer. . 

Table 8-1 Addressing Modes 

ValueID: Used to specify the value that will be read or written. 
 

Value  Description 
0xC0 All inputs 
0xC1 All inputs that are controlled1 
0xC2…0xC7 Inputs 1-6 
0xC8 Reserved 
0xC9-0xCB Outputs 1-3 
0xCC-0xCF Reserved 
0xD0 Reserved 
0xD1 All sliders that are controlled1 
0xD2-0xD7 Sliders 1-6 

 
 You can find detailed explanation in the sections of the commands.  
 
Value: The specified value will be written to this byte.  
 
<CR> #13 0x0D End 
 
 
 
8.3 Commands 
 
 

Device Command Dec (Hex) ValueID Value Description 
Set value 128 (0x80) See ValueID Value in steps Sets device values 

(volume etc.) 
Increase value 129 (0x81) See ValueID Delta in steps Increases device values 

(volume etc.) 
Decrease value 130 (0x82) See ValueID Delta in steps Reduces device values 
Switch to Configuration 131 (0x83) 0xC0 ConfigNr Switches configuration 
Reserved 132-136 

(0x84-0x88) 
- - Reserved Area for 

compatibility with existing 
ITEC products 

Toggle mute 137 (0x89) 0xC0 See description 
of command 

Mute/Unmute of specific 
Channels  

Reserved 138-147 
(0x8A-0x93) 

- - Reserved Area 

Set Slider Control 148 (0x94) 0xC0 See description 
of command 

Sets controlled flags of 
visible sliders on runtime 

                                                
1  Inputs/Sliders that are controlled are not affected by the  MasterVolume and Media Remote Controls 
(see 4.4). 
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Reserved 149-159 
(0x95-0x9F) 

- - Reserved Area 

Get Data 160  (0xA0) See description 
of command 

Not relevant Fetch device specific 
data (volume etc.) 

Get RAM Range 176 (0xB0) Address Pageadr + 
Length 

Fetch a certain memory 
area from the RAM of the 
device. 

Table 8-2 Media Control Commands 

 
8.3.1 Set value (Command 0x80) 
This command sets device specific values. 
 
Parameters 
 

ValueID: Used to specify the value that will be read or written. 
 

Value  For Inputs this value corresponds to the volume. This can be set from  
0 to 192 dB in 0.5 dB steps. (1 Step=0.5 dB, 0=Mute, 192=Max.). 

 
  For Outputs the values can be set from  –96dB to +20dB in 1dB  

steps. 
The received values will be interpreted as a plus or minus byte value  
 (-128 – +127). Positive values greater than +20dB will be ignored and  
replaced by a +20dB setting. 

 
Example: 

 
Value Output setting 

0 0 dB 
10 (0x0A) +10 dB 
20 (0x14) +20dB 
21-127  +20 dB will be set. 
255(0xFF) -1 dB 
246(0xF6) -10 dB 
128(0x80) -128 dB  

 
 
For slider values, the values can be set directly  
without knowledge of the corresponding volume levels.  

 
 
8.3.2 Increase value (Command 0x81) 
You can use this command to increase a preset value.  
 
Parameters 
 

ValueID see command Set value (Command 0x80) 
 

Value  Increase increment  
   If modifying slider values, the increment is always: 1  
 
Note: In firmware versions up to 1.20, this command is implemented exclusively for slider 
values. 
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8.3.3 Decrease value (Command 0x82) 
You can use this command to decrease a preset value.  
 
Parameters 
 

ValueID see command Set value (Command 0x80)  
 

Value  Decrease increment  
.  

 
Note: In firmware versions up to 1.20, this command is implemented exclusively for slider 
values. 
 
 
 
8.3.4 Switch to Configuration (Command 0x83) 
You can remotely switch a device between configurations using this command. 
 
Parameters 
 

ValueID 0xC0 
 Value  ConfigNr  
   The number of the desired configuration. Valid range: 1-5 
   If the value is set to 0, the configuration will be read, not switched. 
   1 ... Switch to custom configuration 1 
   2 ... Load most recently saved configuration 
   3 ... Switch to custom configuration 2 
   4 ... Switch to custom configuration 3 
   5 ... Switch to custom configuration 4 
 
  
 The switching process follows the following rules: 

- If the selected configuration does not exist, the current configuration is 
reloaded. 

- If the selected configuration is already active, a restart is triggered as well. 
- The switch can take up to 1,5 sec. A response is sent afterwards. 

 
8.3.5 Toggle Mute (Command 0x89) Firmware 1.22 
 
This command is used to mute or unmute specific output channels. 
 
Parameter 
 

ValueID 0xC0 
Value  valid range from 0 to 7 
  Bit 0  Mute/Unmute Output Channel 1 

 Bit 1  Mute/Unmute Output Channel 2 
  Bit 2 Mute/Unmute Output Channel 3 
 

Value 
B7 B6 B5 B4 B3 B2 B1 B0 
- - - - - Channel3 Channel2 Channel1 

 
An activated bit toggle the current state of the given output channel. 
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8.3.6 Set Slider Control (Kommando 0x94) Firmware 1.22 
This command is used to enable the sliders, which are controlled by the encoder button or by 
Media Remote Control commands. 
  
Parameter 
 

ValueID 0xC0   
 Value  0-63 
 

Value 
B7 B6 B5 B4 B3 B2 B1 B0 
- - In1 In2 Line In3 In4 In5 

 
Examples 
 

• Only Inputs In3-In5 (Value=0x07) should be controlled 
Send the following command: 

   

Device ID Command ValueID Value <CR> 
0x01 0x94 0xC0 0x07 0x0D 

 
• All Inputs In1-In5 (Value=0x37) are controlled with the following command: 

   

Device ID Command ValueID Value <CR> 
0x01 0x94 0xC0 0x37 0x0D 

 
• Only the line input (Value=0x08) is controlled by sending the following command: 

   

Device ID Command ValueID Value <CR> 
0x01 0x94 0xC0 0x08 0x0D 

 
 
 
8.3.7 Get Data (Command 0xA0) 
This command reads device specific values. It is designed to exclusively support internal 
system communication. Therefore, a detailed description is not supplied. 
 
8.3.8 Get Ram Range (Command 0xB0) 
This command reads a memory area from the RAM of the device controller. It is designed to 
exclusively support internal system communication. Therefore, a detailed description is not 
supplied. 
 
 ValueID and Value are used as illustrated by Table 8-3: 
  

ValueID Value 
B7 B6 B5 B4 B3 B2 B1 B0 B7 B6 B5 B4 B3 B2 B1 B0 

Address PageAddr. Length 
Table 8-3 Get Ram Range Command 

 Address … 8bit address of the desired location within the RAM Page 
 PageAddr.. Pages 0-7 can be selected. 
 Length …   Length of the data to be fetched. Maximum is 31 bytes. 
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8.4 Response Packet 
 
This chapter describes the response packets sent by the device after having processed 
received commands. 
 
Values outside valid ranges are identified. The remote control will send the current value 
instead of doing any processing in this case. This behaviour can be exploited to retrieve 
values if desired. 
 
 
8.4.1 Response-Packet (Commands 0x80-0x9F) 
 
 

Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 
Device ID Command ValueID1 Value1 <ACK> 

 
ValueID: Specifies the value type (Input, Output, etc.) 
Value: The value that has been set is returned in this byte. This is dependant 
 on the command that has been received. 
  
<ACK>: Acknowledge byte (0x06) 
 
 

Note1: If invalid or broken data has been identified in the command packet, the fields “ValueID” and 
“Value” are filled with 0xFF.  

 
8.4.2 Response-Packet (Commands from 0xA0) 
 
 

Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 .. Byte (n+4) Byte (n+5) Byte (n+6) 
Device ID Command Length n Data0 Data1 ... Data n-1 Checksum <ACK> 

 
Length: Specifies the number of bytes sent in the packet.  
 Maximum is 31 bytes  
    
Data0...Data(n-1): The requested data (n= byte count) 
Checksum: The checksum is used to verify the validity of the response packet. 
 Accumulated sum of all data bytes and the first 3 bytes. 
  

 ∑
+

=

=
4

1
)(

n

i
iByteChecksum  

  
  
<ACK>: Acknowledge byte (0x06) 
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8.5 Communication Examples POWERMIX/RPSUCCESS – Remote 
Control 

 
 
 
1. Set volume of input channel 1 of device #1 to -20dB 
 

Command:  Response: 
 

Device ID Command ValueID Value <CR>  Device ID Command ValueID Value <ACK> 
0x01 0x80 0xC2 0x98 0x0D  0x01 0x80 0xC2 0x98 0x06 

 (192 – 20*2 = 152 = 0x98)  
 
 
2. Mute input channel 2 on device #1 
 

Command:  Response: 
 

Device ID Command ValueID Value <CR>  Device ID Command ValueID Value <ACK> 
0x01 0x80 0xC3 0x00 0x0D  0x01 0x80 0xC2 0x00 0x06 

 
 
 
3. Fetch value of slider 2 on device #1 (Increase value command) 
 
Command:  Response: 
 

Device ID Command ValueID. Value <CR>  Device ID Command ValueID Value <ACK> 
0x01 0x81 0xD3 0x00 0x0D  0x01 0x81 0xD2 0x04 0x06 

   
The value byte will return the value set on slider 2 of the device. 
 
 
4. Increase value of slider 1 (input 1) of device #1 - 3 steps 
 

Command:  Response: 
 

Device ID Command ValueID. Value <CR>  Device ID Command ValueID Value <ACK> 
0x01 0x81 0xD2 0x03 0x0D  0x01 0x81 0xD2 0x03 0x06 

   
 
 
5. Set output channel 1 of device #1 to -128 dB (mute) 
 

Command:  Response: 
 

Device ID Command ValueID Value <CR>  Device ID Command ValueID. Value <ACK> 
0x01 0x80 0xC9 0x80 0x0D  0x01 0x80 0xC9 0x80 0x06 

 
 

 
6. Switch to configuration Nr.0 on device #3 
 
Command:  Response: 
 

Device ID Command ValueID Value <CR>  Device ID Command ValueID Value <ACK> 
0x03 0x83 0xC0 0x01 0x0D  0x03 0x83 0xC0 0x01 0x06 
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9. Appendix 
 
9.1 Document Versioning 
 
 
Document version Date Important changes to the previous version  
1.0 24.08.2005 First official English release 
1.1 15.03.2006 New media commands added 
1.2 18.04.2007 Description of new features in extra menu 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
9.2 Contact Information 
 
ITEC Tontechnik 
und Industrieelektronik GesmbH 
A-8200 Lassnitzthal 300 
 
Tel.: +43 (0) 3133 / 3780-0 
Fax: +43 (0) 3133 / 3780-9 
 
office@itec-audio.com 
www.itec-audio.com 

http://www.itec-audio.com/itec_audio_D/1_unternehmen/1_2_kontakt/kontakt.php
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